This document applies to software versions Release 10.1 and later.

All rights reserved. This document may not be copied in whole or in part or reproduced in any other media without the express written permission of Aperio Technologies, Inc. Please note that under copyright law, copying includes translation into another language.

User Resources
For the latest information on Aperio Technologies products and services, please visit the Aperio Technologies website at: http://www.aperio.com.

Disclaimers
Use normal care in maintaining and using the Spectrum servers. Interrupting network connections or turning off the Spectrum and DSR servers while they are processing data (such as when they are analyzing digital slides or generating an audit report) can result in data loss.

This manual is not a substitute for the detailed operator training provided by Aperio Technologies, Inc., or for other advanced instruction. Aperio Technologies Field Representatives should be contacted immediately for assistance in the event of any instrument malfunction. Installation of hardware should only be performed by a certified Aperio Technologies Service Engineer.

ImageServer is intended for use with the SVS file format (the native format for digital slides created by scanning glass slides with the ScanScope scanner). Educators will use Aperio software to view and modify digital slides in Composite WebSlide (CWS) format.

Aperio products are FDA cleared for specific clinical applications, and are intended for research use for other applications. For clearance updates, visit www.aperio.com

Trademarks and Patents
ScanScope is a registered trademark and ImageServer, TMALab, ImageScope, and Spectrum are trademarks of Aperio Technologies, Inc. All other trade names and trademarks are the property of their respective holders.

Aperio products are protected by U.S. Patents: 6,711,283; 6,917,696; 7,035,478; 7,116,440; 7,428,324; 7,457,446; 7,463,761; 7,502,519; 7,518,652; and licensed under one or more of the following U.S. Patents: 6,101,265; 6,272,235; 6,322,774; 6,522,774; 6,775,402; 6,396,941; 6,674,881; 6,226,392; 6,404,906; 6,674,884; and 6,466,690.

Contact Information

<table>
<thead>
<tr>
<th>Headquarters</th>
<th>Europe Office</th>
<th>Asia Office</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aperio Technologies, Inc.</td>
<td>Aperio UK Ltd</td>
<td>Aperio Technologies, KK</td>
</tr>
<tr>
<td>1360 Park Center Drive</td>
<td>The Vineyard</td>
<td>UZ Building SF</td>
</tr>
<tr>
<td>Vista, CA 92081</td>
<td>Axbridge</td>
<td>3-3-17, Surugadai</td>
</tr>
<tr>
<td>United States</td>
<td>Somerset BS26 2AN UK</td>
<td>Kanda, Chiyoda-ku</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tokyo, Japan 101-0062</td>
</tr>
</tbody>
</table>

United States of America
Tel: 866-478-4111 (toll free)
Fax: 760-539-1116

Customer Service
Tel: 866-478-4111 (toll free)

Technical Support
Tel: 866-478-3999 (toll free)

Email
Email: support@aperio.com

Europe
Tel: +44 (0) 1934 733679
Fax: +44(0) 1934 733660

Customer Service & Technical Support
Tel: +44 (0) 1934 733679

Email
Email: europesupport@aperio.com

Asia
Tel: +81–3–3259–5255
Fax: +81–3–3259–5256

Customer Service
Email: asiainfo@aperio.com

Technical Support
Email: asiasupport@aperio.com
Contents

CHAPTER 1 – INTRODUCTION ................................................................. 1
  Aperio Algorithms ................................................................................. 1
    Prerequisites ......................................................................................... 2
  FDA Cleared Image Analysis Algorithms .............................................. 2
  Intended Use .......................................................................................... 3
  IHC Quick Analysis .................................................................................. 3
    Slide-Specific Processing ...................................................................... 3
    Other Options ....................................................................................... 4

CHAPTER 2 – ALGORITHM INSTALLATION ......................................................... 7
  Where to Install the Algorithm ............................................................... 7

CHAPTER 3 – OPENING A DIGITAL SLIDE FOR ANALYSIS .......................................... 9
  About ImageScope .................................................................................. 9
  Accessing a Digital Slide in Spectrum .................................................... 10
  Opening a Local Digital Slide ............................................................... 12
  Opening a Remote Digital Slide ............................................................. 14
  For More Information ........................................................................... 15

CHAPTER 4 – SELECTING AREAS TO ANALYZE .................................................. 17

CHAPTER 5 – REGISTERING THE ALGORITHM ON SPECTRUM ................................. 21
  Opening the Digital Slide ...................................................................... 21
  Creating a New Macro ............................................................................ 22
  Saving and Registering the Macro on Spectrum ....................................... 26
  Testing and Modifying an Existing Macro ............................................. 27
  Using the Tuning Window to Test Algorithm Parameters ....................... 28

CHAPTER 6 – RUNNING THE ANALYSIS........................................................... 31
  Analyzing in ImageScope ...................................................................... 31
  Spectrum Analysis Batch Jobs .............................................................. 33
  For More Information ............................................................................ 35

CHAPTER 7 – EXPORTING RESULTS ............................................................. 37
  Exporting Results as Text ...................................................................... 38
  Exporting Results to a Spreadsheet ...................................................... 38

APPENDIX A – TROUBLESHOOTING ............................................................ 39

INDEX.................................................................................................. 41
Introduction

This chapter introduces Aperio image analysis algorithms.

The process of analyzing digital images begins with the digital slide, a digital image created by scanning glass slides. Using Aperio image analysis algorithms to analyze digital slides provides several benefits:

- **Increases productivity** – Image analysis automates repetitive tasks.
- **Improves healthcare** – Analyzing digital slides helps you to examine slide staining to find patterns that will tell you more about the slide. Using an algorithm to look for these patterns provides precise, quantitative data that is accurate and repeatable.
- **Development of new computer-based methods** – Image analysis helps you answer questions that are beyond the capabilities of manual microscopy, such as “What is the significance of multiple stains at the cell level and colocalization of stains?”
- **Workflow integration** – The Spectrum digital pathology information management software suite integrates image analysis seamlessly into your digital pathology workflow, requiring no additional work by the lab or pathologist. With the click of a button, the algorithm is executed while you review the digital slide.

**Aperio Algorithms**

Analyzing a digital slide is done by applying algorithms directly to the digital slide or selected regions of the digital slide after opening the digital slide in ImageScope.

Using image analysis algorithms can answer such questions as:

- Where and how much staining is there?
- Where and how many objects (for example, tumor cells) are there?
- How much staining is there on different objects (for example, cell nuclei)?

Several algorithms developed for specific applications are available, including:

- **Positive Pixel Count** – This algorithm quantifies the area and intensities of two stains based on user-defined values for color and intensity thresholds.
- **Color Deconvolution** – The professional version of the positive pixel count algorithm, Color Deconvolution accurately separates stains, resolving multi-stain colocalization problems. This algorithm separates the image into three channels corresponding to the actual colors of the stains used. This allows the pathologist to accurately measure the area for each stain separately, even when the stains are superimposed at the same location.

- **Colocalization** – The Colocalization algorithm is an extension of the Color Deconvolution algorithm, quantifying the area and intensities of “colocalized” markers.

- **Rare Event Detection** – The rare event detection algorithm is often used to detect micrometastasis of tumor cells found in circulating blood.

The Positive Pixel Count algorithm is provided for free with Aperio software. Other algorithms are available from Aperio for a fee. Algorithms have also been developed by third parties and tools are available from Aperio for creating your own algorithms—contact Aperio for details.

These algorithms all have control parameters—for example, intensity and hue settings—that allow the algorithm to be tailored to your specific needs.

**Prerequisites**

The examples in this guide assume you are using Aperio Release 10 or later.

Because Aperio digital slides are by design high resolution and information rich, for best results you should use a high quality monitor to view them. Make sure the monitor is at the proper viewing height and in a room with appropriate lighting. We recommend any high quality LCD monitor meeting the following requirements:

<table>
<thead>
<tr>
<th>Display Type</th>
<th>CRT minimum, LCD (flat panel) recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Resolution</td>
<td>1024(h) x 768(v) pixels minimum, 1920 x 1050 or larger recommended.</td>
</tr>
<tr>
<td>Screen Size</td>
<td>15” minimum, 19” or larger recommended</td>
</tr>
<tr>
<td>Color Depth</td>
<td>24 bit</td>
</tr>
<tr>
<td>Brightness</td>
<td>300 cd/m² minimum, 500 or higher recommended</td>
</tr>
<tr>
<td>Contrast Ratio</td>
<td>500:1 minimum, 1000:1 or higher recommended</td>
</tr>
</tbody>
</table>

**FDA Cleared Image Analysis Algorithms**

Several Aperio algorithms have been cleared by the FDA for clinical use when used on ScanScope models that are labeled as approved medical devices, and are intended for research use for other applications. These algorithms have their own user guides. Please see the Intended Use section of the user guides for the specific cleared applications you wish to use for details on in vitro diagnostic use.


**Intended Use**

Algorithms are intended to be used by trained pathologists who have an understanding of the conditions they are testing for in running the algorithm analysis.

Each algorithm has input parameters that must be adjusted by an expert user who understands the goal of running the analysis and can evaluate the algorithm performance in meeting that goal.

You will adjust (tune) the parameters until the algorithm results are sufficiently accurate for the purpose for which you intend to use the algorithm. You will want to test the algorithm on a variety of images so its performance can be evaluated across the full spectrum of expected imaging conditions. To be successful, it is usually necessary to limit the field of application to a particular tissue type and a specific histological preparation. A more narrowly defined application and consistency in slide preparation generally equates to a higher probability of success in obtaining satisfactory algorithm results.

If you get algorithm analysis results that are not what you expected, please see Appendix A, “Troubleshooting” on page 39 for assistance.

**IHC Quick Analysis**

The examples in this guide show the use of the ImageScope detailed Annotations window, which provides a general solution for image analysis. However, a more streamlined version of image analysis is also available that uses the ImageScope Annotations summary view. The Annotations summary view was specifically developed for analyzing IHC digital slides and make the process quicker and simpler by fitting into a pathologist’s or researcher’s normal activities.

For details on using the Digital IHC features, on setup steps for Spectrum, and for guidelines on creating validation studies for the specific IHC application you want to use, see:

- *Digital IHC User’s Guide*
- *Digital IHC Guide to Spectrum Setup*
- The user’s guide for the specific IHC application you are using.

**Slide-Specific Processing**

The key to the Digital IHC workflow is *slide-specific processing*, which defines how a digital slide will be processed based on its stain and type of tissue (body site). The slide-specific processing can define what algorithm will be used to analyze that type of slide, how analysis results will be display and how to interpret those results (alternatively, manual scoring can be set up for the slide), and what comments will be available to be used by the pathologist or researcher viewing the slide.
The slide-specific configuration for each stain/body site combination is defined by the Spectrum administrator. See the Digital IHC Guide to Spectrum Setup for details.

Once slide-specific processing is set up, viewing, annotating, and analyzing a digital slide becomes a quick process that takes just a few mouse clicks.

The summary view of the Annotations window is designed specifically for working with IHC digital slides to provide a quick way to mark tumor regions and analyze them in one simple step.

To open the Annotations window in summary view:

1. Identify a digital slide in Spectrum for which stain/body site slide-specific processing has been defined.
2. From the Spectrum page, open the digital slide in ImageScope by clicking its thumbnail. The Annotations window in summary view appears. (If the window does not look like this, click the Summary button to return the Annotations window to the summary view):

   ![Annotations window](image)

   The algorithm appropriate for this type of slide is listed in the drop-down box. You can select another algorithm if you wish from that box.

   From this window you can draw annotations to identify areas to analyze and run the analysis all in one easy step.

   For details on using the Annotations summary view window, see the Digital IHC User’s Guide.

**Other Options**

- To navigate between annotations you have drawn, use the numbered buttons or arrow keys. (As you draw annotations, the buttons at the top of the window display a number for each annotation.) When you select an annotation in this way, that annotation is centered in the ImageScope window.
To see a report image you have selected, select Report Image from the drop-down list.

To create an annotation that will not be used for analysis (for example, a ruler or arrow), select Annotations from the drop-down list before drawing.
Algorithm Installation

The instructions in this section apply to all Aperio algorithms.

If you purchased an algorithm when you purchased a ScanScope, the algorithm may already be installed on your ScanScope server. (In this case, the algorithm installer program will also be located on your ScanScope server in C:\AperioInstall).

Or, you may have received information from Tech Support on where to download the algorithm installer so you can install the algorithm yourself.

Installing an algorithm is a simple matter of using Windows Explorer to navigate to the location of the algorithm installer file and double-clicking the file name.

Follow the instructions of the algorithm installer, clicking Next when instructed to do so.

Where to Install the Algorithm

Where you install the algorithm depends on how you are going to be analyzing digital slides:

- **Analyzing digital slides through Spectrum** – If you are going to be using Spectrum to analyze a single digital slide or a batch of digital slides, you will need to install the algorithm on both your local workstation and on DSR (Digital Slide Repository), which is the server or computers connected to the server on which AAFClient is installed.

  You will also need to register the algorithm macro on Spectrum. See Chapter 5, “Registering the Algorithm on Spectrum” on page 21 for details.

- **Analyzing local digital slides** – If you will be using the algorithm to analyze local digital slides (that is, digital slides that are located on your workstation or on your network where they can be accessed by Microsoft file sharing), install the algorithm on your workstation. However, be aware that when analyzing local digital slides, the analysis results are stored on your workstation, not in the Spectrum database.

- **Analyzing remote digital slides** – If you will be using the algorithm to analyze remote digital slides (that is, digital slides that are located on your Aperio ImageServer) by opening the digital slide directly on the
ImageServer, install the algorithm on the DSR (the server or computers connected to the server on which AAFClient is installed).

- **Creating analysis macros** – No matter where you are going to analyze digital slides, if you are going to *create* an algorithm macro, you need to install the algorithm on your local workstation as well as on the locations discussed above. (You will need to create and save an algorithm macro to analyze digital slides on Spectrum.)
Before you can analyze a digital slide, you will open it for viewing in ImageScope. You can either open the slide in Spectrum or directly from ImageScope.

There are several different ways to open a digital slide for viewing depending on whether the digital slide is local or remote.

- Local digital slides reside on your workstation or on your local network where you can access them in ImageScope using Microsoft file sharing.
- Remote digital slides reside on a remote server where you can access them directly in ImageScope or by first going through Spectrum.

In most cases, we expect you to open a digital slide in Spectrum. Other methods of access are discussed at the end of this chapter.

**About ImageScope**

In most cases you will be using ImageScope to view and analyze digital slides. In addition to the basic features shown in this guide, ImageScope also contains many advanced features that will help you view and assess digital slides:

- **Image Quality (IQ)** – the IQ feature is available when your site is licensed for Spectrum Plus and when you open a digital slide in ImageScope from Spectrum. IQ contains a variety of tools that help you to better assess a digital slide based on its stain. In addition to allowing you to view stain channels separately, IQ also remaps stain colors, accentuates cellular detail and recombines stains. For details, see the *IQ Image Quality User’s Guide*.

- **Scale Axes and Grid** – You can optionally overlay the digital slide image with measurement axes and axes/grid.

- **ImageScope Ruler** – The ImageScope ruler tool allows you to measure an object on the digital slide by drawing on the slide.

For more information, see the *ImageScope User’s Guide*. 
Accessing a Digital Slide in Spectrum

Cases (or projects), specimens and digital slides are managed using Aperio’s Spectrum. A pathologist who wants to access a digital slide first needs to log into Spectrum and navigate to the case and the specimen that shows the list of its associated digital slides.

Please ask your Spectrum administrator for the Spectrum web-address, your logon name, and a password.

1. Open Microsoft Internet Explorer (or another web viewer like Firefox) and enter the Spectrum web-address. You see a login page.

2. Log onto Spectrum by entering your user name and password. (The password is case sensitive.)

3. If more than one user role is assigned to your login, you are asked to choose which user role you want to log in with:

   Please Choose a Role
   - Lab_Supervisor - Lab supervisor with administrative privileges
   - Pathologist - Pathologist

To analyze digital slides and to create and change algorithm macros, the user role you log in with must have the following command permissions enabled:
- Analysis Macros – Add, Edit
- Images – Analyze.

Contact the Spectrum administrator if you are not sure if your user role allows these actions.
Chapter 3 – Opening a Digital Slide for Analysis

After logging in, you see the Spectrum main page:

The exact categories of data you see depend on your Spectrum configuration and options. For the purposes of this guide, we will assume Spectrum Plus is configured for clinical or research use.

4. Navigate to the list of cases by clicking **List all Cases** (or to the list of projects by clicking **List all Projects**).
5. Open the case or project you want to review by clicking the open data icon for the case or project.

You now see the case or project information page that contains details about that case or project.

6. On the detail page, move down to the Digital Slides area of the page and open a digital slide in ImageScope by clicking its thumbnail in the digital slide list.

Although you usually will want to find a digital slide by going to its parent case, project, or specimen, you can also use Spectrum’s search functions to find a specific digital slide, or you can go to the digital slide table on the main page to browse all digital slides.

**Opening a Local Digital Slide**

To open a digital slide that resides on your workstation or local area network:

1. Start ImageScope by clicking **Start**, pointing to **All Programs > ScanScope**, and then selecting **ImageScope**.

2. Go to the **File** menu and select **Open Image** (or click 📝 on the ImageScope toolbar).
3. On the Open Image window, navigate to the location that contains the image you want to view.

4. Click the name of the digital slide you want to open and click **Open**.

You may need to change the file type in the Open Image window to see the type of image you want to view. For example, to view a CWS image, click the file type drop-down list and select **Composite WebSlides (*SlideScan.ini)**.
Chapter 3 – Opening a Digital Slide for Analysis

Opening a Remote Digital Slide

To open a remote digital slide directly from within ImageScope without going through the Spectrum user interface:

1. Go to the ImageScope File menu and select Access Remote Server to connect to Spectrum. Enter the name of the server containing the digital slides (usually the server on which Spectrum resides):

   ![Access Remote Server dialog box]

2. Set the Port value to 82.
3. Click Connect.
4. When asked for your user name and password, enter your Spectrum user name and password.
5. Now you see a page of digital slides on the Spectrum site. You can choose between two views: List and Thumbnail by selecting the view you want from the drop-down list at the upper right.

6. Select a digital slide by clicking ImageScope beneath an image.

For More Information

For more information on opening a digital slide in ImageScope, see the ImageScope User’s Guide.
Selecting Areas to Analyze

You can analyze an entire digital slide or just selected areas. This chapter discusses how to select areas of the digital slide to analyze.

Whether you decide to use an algorithm directly in ImageScope or wish to use Spectrum’s batch analysis feature, you may want to first use ImageScope to select areas of interest in the digital slide to analyze.

1. Open a digital slide in ImageScope. See Chapter 3 “Opening a Digital Slide for Analysis” on page 9 for instructions on opening a digital slide in ImageScope.

After opening the digital slide, you see the main ImageScope viewing window:
2. Now you can use the ImageScope drawing tools to select (or exclude) areas to analyze.

   For example, in the image below we used the following tools on the ImageScope toolbar:
   - **Freehand pen** – Use to draw a free-form area of interest.
   - **Negative freehand pen** – Use to draw an area to *exclude* from the analysis. Note that you can use this in combination with the other drawing tools to first select an area of interest and then exclude areas within the selected area that you do not want to analyze.
   - **Rectangle tool** – Draws a rectangular area. If you want to select a square, hold down the Shift key while drawing.

   If you have defined a fixed size for annotations, hold down the Control key while you use the drawing tool to draw an annotation of that predefined size. (See the *ImageScope User’s Guide* for details on this feature.)

3. To see information about the annotations you have drawn, go to the ImageScope View menu and select **Annotations**.
Each of the three annotations we drew is listed in the Layer Regions panel, with area and length measurements (in microns). To select a specific annotation (for example if you want to delete it or move it), click it in the ImageScope image or click it in the Layer Regions panel of the Annotations window and you see it highlighted on the ImageScope main window.

For example, below we clicked on annotation 1 (the rectangular annotation) and see that its boundary contains a dark line showing it is selected:

To delete the selected annotation, press the Delete key on your keyboard or click the red X in the Layer Regions pane. To move it, hold down the Control key and drag it on the ImageScope main window.
5

Registering the Algorithm on Spectrum

An algorithm macro is an algorithm and its settings. Before you can use an algorithm on Spectrum, you must create an algorithm macro and save it on Spectrum.

To analyze a digital slide on Spectrum, you will need to create an algorithm macro and register it on Spectrum. Creating a macro is a simple matter of adjusting the parameters of the algorithm and saving those settings.

In order to create an algorithm macro, you need to install the algorithm on both your local workstation and on Spectrum. (This consists of simply running the algorithm installer on both computers.)

Note that creating and registering a macro requires that you log into Spectrum as an administrator.

Opening the Digital Slide

You can either open a remote digital slide in Spectrum or open the remote digital slide directly in ImageScope. See Chapter 3, “Opening a Digital Slide for Analysis” on page 9 for details.

Open a digital slide you will use to create an algorithm macro.
Creating a New Macro

1. Log into Spectrum as an administrator.

2. From Spectrum, after opening a digital slide in ImageScope, go to the ImageScope View menu and select Analysis. You see the Algorithm Server Job window:

Because you are going to create a new algorithm macro, you won’t select one of the macros listed in the window.

3. In the Region of Analysis section, click one of the following selections:
   a) **Entire Image** – When analyzing the image, testing an existing macro, or creating a new macro, the entire image will be used.
   b) **Selected Annotation** – When analyzing the image, testing an existing macro, or creating a new macro, only the portion of the image defined by the active annotation will be used. If no annotations exist for the image, **Entire Image** is automatically selected.
Chapter 5 – Registering the Algorithm on Spectrum

4. Click the Create button to make a new macro. The Select an Algorithm window appears:

![Select an Algorithm Window]

5. Select the algorithm you want to create a macro for by clicking it in the list and then clicking Select. If you don’t see the algorithm you want to use listed, you will need to install that algorithm on the Spectrum server and on your workstation.

The Create button creates a new macro based on the selected algorithm. This loads the algorithm macro with its default parameters so you can see its unmodified parameters. The Analysis window now appears.

![Analysis Window]

6. If not already selected, click Inputs and modify the parameters (referring to the user guide for particular algorithm you are using for guidelines). If
the algorithm you are using does not have any inputs, skip to the next step.

7. Click Outputs and select the output results you want to display in Spectrum (clearing the check boxes next to the results you don’t want to display):

![Macro on server spectrum](image)

8. Click Run to test the macro on the digital slide.

When the analysis is complete, the markup image in the main ImageScope window shows the results:

![Mark up](image)

In this example, we drew a rectangle to select the area we wanted to analyze, but also used the negative freeform pen to exclude areas within the rectangle from analysis. (See Chapter 4, “Selecting Areas to Analyze,” on page 17 for information on using the ImageScope drawing tools.)
For information on the meaning of the colors shown in the mark-up image, see the numerical results displayed in the Annotiations window and the documentation for the algorithm you are using.

To see the numerical results of the analysis:

1. Go to the ImageScope View menu and select **Annotations**.

Note the color shown next to each parameter—that is the color for that result shown in the mark-up image.

Keep adjusting the algorithm parameters until you are satisfied with the results. Then save the macro (see the next section).
Saving and Registering the Macro on Spectrum

After you have created the macro, save it to register it on Spectrum.

1. On the Analysis window, click **Save Macro** to save the macro and register it on Spectrum:

   ![Save Macro interface](image)

2. You are asked to enter a name for the macro:

   ![Save macro interface](image)

   Type a name that will help you identify the macro in the future and click **OK**.

   You now see a message letting you know that the macro is saved. It is now registered on Spectrum.

   Now, when you bring up the Analysis window, you will be able to select your macro by clicking Select Algorithm because your macro will appear in the list.
Testing and Modifying an Existing Macro

After opening an image from Spectrum, when you select **Analysis** from the View menu, you see the Algorithm Server Job window:

The **Test** button modifies an existing macro for the algorithm you have selected and tests it before saving it to Spectrum. Using the **Test** button loads the algorithm macro with its existing parameters.
Chapter 5 – Registering the Algorithm on Spectrum

Modify the parameters and click **Run** to test it on the digital slide. (Or click the **Tune** button to test the algorithm parameters as discussed in the next section.)

When you are satisfied with the results, click the **Save Macro** button as discussed in the previous section to save the modified macro.

**Using the Tuning Window to Test Algorithm Parameters**

The algorithm tuning window gives you a way to quickly see the results of analyzing a different area of an image or to test changes you make to the algorithm parameters.

To use the algorithm tuning window:

1. In Spectrum, open a digital slide in ImageScope.
2. In ImageScope, go to the View menu and select **Annotations** to open the Annotations window. This window is where your numeric algorithm analysis results appear.
3. Go to the View menu and select **Analysis**.

You see the Algorithm Server Job window where you can select the algorithm macro you want to use.

These instructions discuss using the tuning window when opening an image from Spectrum. You can also use the algorithm tuning window when you open a local image—just remember that in this case analysis results will be saved locally, not in the Spectrum database. For details on analyzing local images, see the *ImageScope User’s Guide*. 

---

Purdue University is an equal access/equal opportunity/affirmative action university.
If you have trouble accessing this document because of a disability, please contact PVM Web Communications at vetwebteam@purdue.edu.
4. Select the macro you want to use and click **Test**. You see the algorithm parameter window.

![Algorithm parameter window](image)

5. On the algorithm parameter window, click **Tune**. On the ImageScope main window, you see a new Algorithm Tuning window with the mark-up image from the analysis using the current parameters.

![Algorithm Tuning window](image)
You see the numeric results of the analysis in the Annotations window:

6. To adjust the size of the Algorithm Tuning window, grab a corner until you see the double-headed arrow and pull the window to change the size.

7. To see the analysis of another area of the digital slide, drag the Algorithm Tuning window to another area or move the digital slide under the window.

8. To see the results of the analysis when you change the parameters, simply change the parameters in the algorithm parameters window and the Algorithm Tuning window updates to show the analysis using the new parameters.
This chapter discusses how to use an algorithm in Spectrum to analyze a digital slide. This is a general discussion which applies to all algorithms. For details on using a specific algorithm, refer to the user guide for that algorithm.

Once you have identified the digital slide or slides you want to analyze, you can analyze them together in a Spectrum batch analysis, or you can open each one in ImageScope and analyze the digital slides one at a time.

**Analyzing in ImageScope**

You can either analyze the entire digital slide or only selected portions of it (see the previous section for information on selected areas of analysis).

To analyze a digital slide directly in ImageScope:

1. Open a digital slide in ImageScope. See “Accessing a Digital Slide in Spectrum” on page 10 for instructions on opening a digital slide in ImageScope from within Spectrum. For details on opening a digital slide that resides on your workstation or on a non-Spectrum remote server, see “Opening a Local Digital Slide” on page 12 and “Opening a Remote Digital Slide” on page 14.

   For example (in this case we have selected areas to analyze as discussed in the previous section):

![Image of a digital slide with selected areas highlighted]
2. Go to the View menu and select Analysis. The Algorithm Server window appears:

![Algorithm Server Job - Server: spectrum](image)

3. Click an algorithm macro to select it. (If the algorithm you want to use doesn’t appear in this window, a macro for the algorithm has to be created and saved on Spectrum. See the previous chapter for details.)

4. Click the appropriate radio button to select the area of the digital slide to analyze:
   a) **Entire Image** – The part of the image shown in the ImageScope main window.
   b) **Selected Annotation** – Analyze only the areas selected by drawn annotations in the current annotation layer. (If you have more than one layer of annotations, go to the Annotations window and select the annotation layer in the Layers pane that contains the drawings that select the areas to analyze.)

5. Select the **Generate Markup Image** check box to create a pseudo-color markup image.
7. Click **Analyze** to start the analysis. If you have selected the **Generate Markup Image** check box, the image in the ImageScope window shows the visual results of the analysis. The Annotations window shows the analysis result data. You can export the analysis results in an Excel spreadsheet or as text using the icons in the Annotations window (see Chapter 7, “Exporting Results,” on page 37 for details).

---

**Spectrum Analysis Batch Jobs**

Spectrum provides a convenient tool for batch analysis of slides. Before you can batch analyze selected slide images in Spectrum, the Spectrum administrator must first create a macro for each image analysis algorithm you want to use for analysis.

Analysis can be taking place while you continue to work within Spectrum, organizing data and annotating images.

1. Display the desired list of digital slides.
   - Open a specific case or project to see the digital slides associated with that case/project.
   - You may list all slides by going to the Digital Slides menu and selecting **All Digital Slides (As List)**.
   - Or, you may want to search within the slides for a specific stain or status. (See the Spectrum/Spectrum Plus Operator’s Guide for more information.)
2. Select the box to the left of each slide to be batch analyzed.

3. Click Analyze.

The Analysis page appears:

4. Select the analysis macro of your choice. If you don’t see the algorithm you want to use, see Chapter 5, “Registering an Algorithm on Spectrum” on page 21 for instructions on creating and saving an algorithm macro.

5. If you want to analyze only a portion of the image, select a specific annotation layer in the Select Input Annotation Layer section or click Most Recent to select the annotations in the most recently created annotation layer. If you want to analyze the entire digital slide, select Whole Image.

(See Chapter 4, “Selecting Areas to Analyze,” on page 17 for information on drawing annotations to select areas to analyze.)

6. Select the Create markup image(s) check box if desired.
7. Click **Analyze**. The slides chosen for analysis will be added to the **Analysis Job Queue**.

```
3 Pending Analysis Jobs

<table>
<thead>
<tr>
<th>Job ID</th>
<th>Submitted By</th>
<th>Image ID</th>
<th>Image Of</th>
<th>Create Markup</th>
<th>Processing Host</th>
<th>Status</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Dr. Beth Edwards</td>
<td>3</td>
<td>Digital Slide 1</td>
<td>true</td>
<td>Submitted</td>
<td>In Progress</td>
<td>Cancel</td>
</tr>
<tr>
<td>2</td>
<td>Dr. Beth Edwards</td>
<td>1</td>
<td>Digital Slide 1</td>
<td>true</td>
<td>Submitted</td>
<td>In Progress</td>
<td>Cancel</td>
</tr>
</tbody>
</table>
```

See the *Spectrum/Spectrum Plus Operator’s Guide* for information on:
- Checking the progress of the analyses.
- Canceling analysis jobs.
- Viewing the analysis history for specific digital slides.

**For More Information**

For details on using Aperio algorithms to analyze digital slides, see:
- *Spectrum/Spectrum Plus Operator’s Guide* for information on using algorithms to analyze individual digital slides or batches of digital slides.
- *ImageScope User’s Guide* for information on using algorithms to analyze local digital slides on your workstation or local network, or to analyze remote digital slides on an ImageServer.
This chapter discusses how to export analysis results as text or Excel spreadsheet files.

Algorithm analysis results are stored in an annotation layer so you may want to export that information into a text file to include it in a report or to chart the information in a spreadsheet program.

To see the numerical results of the analysis:

1. Go to the ImageScope View menu and select **Annotations**. The Annotations window appears with the results displayed:
Exporting Results as Text

To export the text of the Layer Attributes pane to a text file: On the Layer Attributes pane, click . You will be asked to specify the name and location of the text file to be created. This text file is a tab-delimited file that can be imported into a spreadsheet program.

To export the text of the Layer Regions pane to a text file: On the Layer Regions pane, click . You will be asked to specify the name and location of the text file to be created. This text file is a tab-delimited file that can be imported into a spreadsheet program.

Exporting Results to a Spreadsheet

To export the text of the Layer Attributes pane to a Microsoft Excel spreadsheet: On the Layer Attributes pane, click . You will be asked to specify the name and location of the spreadsheet .xls file to be created.

To export the text of the Regions Attributes pane to a Microsoft Excel spreadsheet: On the Regions Attributes pane, click . You will be asked to specify the name and location of the spreadsheet .xls file to be created.
This appendix provides tips on identifying problems with glass slides that may contribute to unsatisfactory analysis results.

In “Intended Use” on page 2, we discussed the importance of understanding algorithm parameters so that you can fine-tune them so the analysis provides the results you expect and want. Even after adjusting algorithm parameters, a number of factors can arise that may cause the algorithm to yield unsatisfactory results for your application. Detection of these conditions must be done by a trained expert user who can identify these situations and take the appropriate corrective action. In some cases, the appropriate action may be to mark the glass slide as defective. In other cases, it may be that new tuning of the algorithm input parameters is required or the staining/preparation process must be repeated.

This appendix contains a partial list of conditions that may result in unsatisfactory analysis results.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Effect</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defective slide</td>
<td>Broken slide</td>
<td>Blurry image and/or artifacts at crack.</td>
<td>You should reject the slide.</td>
</tr>
<tr>
<td>Air pockets under coverslip.</td>
<td></td>
<td>Image very blurry, objects too light and not easily identifiable. The algorithm will likely miss information in this area.</td>
<td>You can exclude these areas from analysis by using the ImageScope negative-pen annotation tools</td>
</tr>
<tr>
<td>Pen marks</td>
<td></td>
<td>Areas will be dark and will obscure underlying information.</td>
<td>You can exclude these areas from analysis by using the ImageScope negative-pen annotation tool.</td>
</tr>
<tr>
<td>Wrong tissue type</td>
<td>Algorithm tuned for one type of tissue (for example, breast cancer) and operator runs it on another type of tissue (for example, liver).</td>
<td>The algorithm analysis will still give results, but the results will likely be meaningless.</td>
<td>Choose a different algorithm or input parameter set.</td>
</tr>
</tbody>
</table>

Aperio Image Analysis User’s Guide

Purdue University is an equal access/equal opportunity/affirmative action university.
If you have trouble accessing this document because of a disability, please contact PVM Web Communications at vetwebteam@purdue.edu.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Effect</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrong regions designated for analysis</td>
<td>For nuclear analysis, stromal and lymphocytes were included in the designated regions.</td>
<td>Nuclear counts will be too large.</td>
<td>Operator must recognize these areas and annotate them to exclude them from analysis.</td>
</tr>
<tr>
<td>Bad histology preparation</td>
<td>Tissue sections too thick.</td>
<td>Image will be blurry all over.</td>
<td>Prepare new slide.</td>
</tr>
<tr>
<td></td>
<td>Folds in tissue.</td>
<td>Blurry areas and cells that are superimposed on each other.</td>
<td>Prepare new slide or annotate these areas to exclude them from analysis.</td>
</tr>
<tr>
<td>Variations in staining process</td>
<td>Staining is too light.</td>
<td>Cells are not solidly stained and the algorithm may over count by subdividing single cells into multiple cells.</td>
<td>Adjust input parameters if possible or prepare a new slide.</td>
</tr>
<tr>
<td></td>
<td>Staining is too dark.</td>
<td>Cells which are close together become merged and counted as a single cell.</td>
<td>Adjust input parameters if possible or prepare a new slide.</td>
</tr>
<tr>
<td></td>
<td>Staining is not specific to the features being analyzed.</td>
<td>For nuclear analysis, significant cytoplasmic staining may cause cells to be misidentified.</td>
<td>Prepare new slide.</td>
</tr>
</tbody>
</table>

Purdue University is an equal access/equal opportunity/affirmative action university.

If you have trouble accessing this document because of a disability, please contact PVM Web Communications at vetwebteam@purdue.edu.
index

<table>
<thead>
<tr>
<th>Algorithm Installation, 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Algorithm Macro, 21</td>
</tr>
<tr>
<td>Algorithm Tuning Window, 28</td>
</tr>
<tr>
<td>Analysis, 31</td>
</tr>
<tr>
<td>Creating New Macro, 22</td>
</tr>
<tr>
<td>Saving Macro, 26</td>
</tr>
<tr>
<td>Testing/Modifying Macros, 27</td>
</tr>
<tr>
<td>Annotations</td>
</tr>
<tr>
<td>Exporting, 38</td>
</tr>
<tr>
<td>Measuring, 19</td>
</tr>
<tr>
<td>Viewing, 19</td>
</tr>
<tr>
<td>Annotations Window</td>
</tr>
<tr>
<td>Detailed View, 3</td>
</tr>
<tr>
<td>Summary View, 3</td>
</tr>
<tr>
<td>Aperio Release Requirements, 2</td>
</tr>
<tr>
<td>Batch Analysis, 33</td>
</tr>
<tr>
<td>Colocalization Algorithm, 2</td>
</tr>
<tr>
<td>Color Deconvolution Algorithm, 2</td>
</tr>
<tr>
<td>Creating New Algorithm Macro, 22</td>
</tr>
<tr>
<td>Digital Slide, 1</td>
</tr>
<tr>
<td>Analyzing, 31</td>
</tr>
<tr>
<td>Opening In Spectrum, 10</td>
</tr>
<tr>
<td>Opening Local, 12</td>
</tr>
<tr>
<td>Opening Remote, 14</td>
</tr>
<tr>
<td>Exporting Results, 38</td>
</tr>
<tr>
<td>As Spreadsheet, 38</td>
</tr>
<tr>
<td>As Text, 38</td>
</tr>
<tr>
<td>FDA Clearance, 2</td>
</tr>
<tr>
<td>IHC Analysis, 3</td>
</tr>
<tr>
<td>ImageScope, 1</td>
</tr>
<tr>
<td>Advanced Features, 9</td>
</tr>
<tr>
<td>Drawing Tools, 18</td>
</tr>
<tr>
<td>Installation, 7</td>
</tr>
<tr>
<td>Intended Use, 3</td>
</tr>
<tr>
<td>Introduction, 1</td>
</tr>
<tr>
<td>IQ, 9</td>
</tr>
<tr>
<td>Macro, 21</td>
</tr>
<tr>
<td>Creating New, 22</td>
</tr>
<tr>
<td>Saving, 26</td>
</tr>
<tr>
<td>Monitor Requirements, 2</td>
</tr>
<tr>
<td>Opening Digital Slides, 12, 14</td>
</tr>
<tr>
<td>Opening Remote Digital Slide, 14</td>
</tr>
<tr>
<td>Positive Pixel Count Algorithm, 1</td>
</tr>
<tr>
<td>Prerequisites, 2</td>
</tr>
<tr>
<td>Rare Event Detection Algorithm, 2</td>
</tr>
<tr>
<td>Registering Macros On Spectrum, 26</td>
</tr>
<tr>
<td>Running The Algorithm, 31</td>
</tr>
<tr>
<td>Selecting Areas To Analyze, 18</td>
</tr>
<tr>
<td>Slide-Specific Processing, 18</td>
</tr>
<tr>
<td>Troubleshooting, 39</td>
</tr>
</tbody>
</table>

Aperio Image Analysis User’s Guide